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Planning Your Installation

Before you install or upgrade, prepare your environment.

• Identify the components and options to install or upgrade. Sybase® IQ InfoPrimer
includes two components that are installed separately: InfoPrimer Development and
InfoPrimer Server

• Obtain a license for IQ InfoPrimer Server.
• Make sure your system meets all requirements for your installation scenario and planned

use.

Sybase IQ InfoPrimer Server
Sybase IQ InfoPrimer Server is scalable and distributed grid engine, which connects to
datasources, and extracts and loads data to data targets or data sinks, using transformation
flows designed using IQ InfoPrimer Development.

Sybase IQ InfoPrimer Development
Sybase IQ InfoPrimer Development is a graphical user interface (GUI) tool for creating and
designing data transformation projects and jobs. IQ InfoPrimer Development is available only
on Windows.

IQ InfoPrimer Development is divided into two major subcomponents:

• IQ InfoPrimer Development desktop – provides the graphical user interface. Use the
desktop to create and design data transformation projects.

• IQ InfoPrimer Development engine – controls actual processing, such as connecting to
databases and executing procedures.

Obtaining a License
Before installing your product, choose a SySAM license model, determine license server
information, and obtain license files.

1. Decide which SySAM license model to use:

• The unserved license model – obtains licenses directly from the license file. To use an
unserved license, save the license to the same machine on which you are installing the
Sybase product.

Planning Your Installation
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• The served license model – uses a license server to manage the license allocation to
multiple machines.

2. For the served license model, decide whether to use an existing or new license server.

The license server and your product installation do not need to share the same machine,
operating system, or architecture.

3. If you chose the served license model, do one of:

• Install the new license server on a machine that does not have an existing license server.
• To install on a machine that is running a SySAM 1.0 license server, follow migration

instructions in the SySAM Users Guide to migrate to the newer SySAM version.

Note: There can be only one instance of a SySAM license server running on a given
machine. To set up a SySAM 2.0 license server on a machine that is already running a
SySAM 1.0 license server, you must migrate the old license server to SySAM 2. A
migrated license server can serve licenses for both SySAM 1.0 and SySAM 2-enabled
products.

4. Get your host IDs.

When you generate licenses at the Sybase Product Download Center (SPDC), you must
specify the host ID of the machine where the licenses will be deployed.

• For unserved licenses – it is the host ID of the machine where the product will run. If
you are running a product with per-CPU or per-chip licensing that supports SySAM
sub-capacity and want to run the product in a virtualized environment, see SySAM
Users Guide > SySAM Sub-capacity Licensing.

• For served licenses – it is the host ID of the machine where the license server will run.

5. Before installing your product, get license files from SPDC at https://
sybase.subscribenet.com using SPDC access information you receive from Sybase or your
Sybase reseller.

Log in to SPDC by using the information in your SPDC welcome e-mail message.

Note: If you purchased your Sybase software from a Sybase reseller, you receive a Web
key rather than an e-mail message.

If you plan to use sub-capacity licensing, see SySAM Users Guide for information on how
to configure the sysamcap utility.

For more information on SySAM licensing, see the SySAM Users Guide.

Note: You do not need a license file to install and run Sybase IQ InfoPrimer Development.

Planning Your Installation
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Sub-capacity Licensing
Sybase now offers sub-capacity licensing, which lets you license Sybase products on a subset
of the CPUs available on a physical machine.

Platform Support

Table 1. SySAM Virtualization Sub-capacity Compatibility

Vendor Product Platform Support Virtualiza-
tion Type

HP nPar HP IA 11.31 Physical parti-
tion

 vPar Virtual parti-
tion

 Integrity Virtual Machines with
Resource Manager

Virtual ma-
chine

 Secure Resource Partitions OS containers

IBM LPAR AIX 6.1 Virtual parti-
tion

 dLPAR Virtual parti-
tion

Sun Dynamic System Domains Solaris 10 Physical parti-
tion

 Solaris Containers/Zones with
Solaris Resource Manager

OS partition

Intel, AMD VMWare ESX Server* Guest OS:
Windows

VMWare ESX 3.5, Guest
OS: Windows 2003, RH
5.3, SuSe 10

Virtual ma-
chine

VMWare ESX Server Guest OS:
Linux

VMWare ESX 3.5, Guest
OS: Windows 2003, RH
5.3, SuSe 10

Virtual ma-
chine

Xen,** DomainU: Windows Windows 2003 Virtual ma-
chine

Xen, DomainU: Linux RH 5.3, SuSe 10 Virtual ma-
chine

Planning Your Installation
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* VMWare ESX Server excludes Sun Solaris x64, VMWare Workstation, and VMWare
Server.

** Xen excludes Sun Solaris x64.

Enabling Sybase Sub-capacity Licensing
You must have a sub-capacity licensing agreement with Sybase before you can enable sub-
capacity licensing. As with other Sybase licenses, you must generate a license key. For
specific steps, see the SySAM Quick Start Guide.

Note: Keep your license server up-to-date.

Although the installation media include a copy of the most recent SySAM license server,
Sybase recommends that you periodically check for license server updates on the SySAM
Standalone License Servers Web site at http://www.sybase.com/sysam/server.

System Requirements
Before installing IQ InfoPrimer Development and IQ InfoPrimer Server, make sure your
system meets the software and hardware requirements.

Sybase IQ InfoPrimer Development
Learn about the operating system and disk space requirements for Sybase IQ InfoPrimer
Development.

Operating Systems
The platform and operating systems supported by IQ InfoPrimer Development are:

• Windows XP Professional with Service Pack 3 – 32-bit
• Windows XP Professional with Service Pack 3 – 64-bit
• Windows 7 Professional and Enterprise 32- and 64-bit

Disk Space
The minimum amount of disk space required by the IQ InfoPrimer Development is 450MB.

Sybase IQ InfoPrimer Server
Learn about the platforms, operating systems, databases, and database interfaces that IQ
InfoPrimer Server supports.

Planning Your Installation
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Server Platforms and Operating Systems
Lists the platform and operating systems supported by IQ InfoPrimer Server.

Platform Version

HP Itanium • 11.23 – 64-bit
• 11.31 – 64-bit

IBM AIX • 6.1 – pSeries 64-bit

Microsoft Windows • Windows 2003 Standard Edition R2 – 64-bit, Windows 2003
Enterprise Edition R2 – 32-bit and 64-bit

• Windows XP Professional Service Pack 3 – 32-bit and 64-bit
• Windows 7 – 32-bit and 64-bit
• Windows 2008 – 32-bit and 64-bit Standard, Enterprise, and

Data Center editions

Red Hat Enterprise Linux • 5.3 on POWER – 64-bit
• x86 – 64-bit

Sun Solaris • 10 (SPARC) – 64-bit
• 10 Solaris AMD

SuSE Linux Enterprise Server 10 and 11 on POWER and x86 – 64-bit

For a complete list of supported operating systems on each platform, see the Sybase platform
certifications Web site at http://certification.sybase.com.

Disk Space
Know the required disk space for installing IQ InfoPrimer Server.

The minimum amount of disk space required by the IQ InfoPrimer Server is 1GB.

Note: To install SQL Anywhere® 11, the minimum amount of disk space required is 1.6GB.

Interfaces
Sybase IQ InfoPrimer supports interfaces for connecting to destination or source databases.

The supported interfaces are:

• Sybase
• DB2 – supported only for connecting to source databases.
• ODBC – you must install the ODBC driver for IQ that comes with Sybase IQ on the same

machine where Sybase IQ InfoPrimer Development and Server are running, and you must
define a system datasource name (DSN) for the target.

Planning Your Installation
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• Oracle – supported only for connecting to source databases.
• OLE DB – supported only for connecting to Microsoft SQL (MSSQL) Server source

databases.
• SQLite Persistent – supported only for connecting to source databases.

See Sybase IQ InfoPrimer Users Guide > Extract Transform and Load Projects > ETL
Components > Database Connection Settings.

Interface Driver Versions
The interface drivers supported by Sybase IQ InfoPrimer Server.

Driver Version

Sybase native (via Client-Library™) 15.5 ESD #6 (Windows, UNIX, and Linux)

Note: These driver version are automatically installed
with Sybase IQ InfoPrimer.

Adaptive Server® Enterprise ODBC 15.05.x (Windows only)

SQL Anywhere ODBC 11.0.1.x

Sybase IQ 15.3 ODBC 11.00.01.6047 or higher

IBM DB2 native 9.07.x, 9.01.x

IBM DB2 ODBC 9.07.x, 9.01.x (Windows only)

Microsoft SQL Server ODBC 2000.x, 6.01.x (Windows only)

MySQL ODBC 5.01.x (Windows only)

Oracle native (via Oracle Call Interface (OCI)) 10.x,11.x

Databases
Sybase IQ InfoPrimer Server supports repository, source, and destination databases.

Database Repository Source Destination Stage

Sybase Adaptive Serv-
er Enterprise 15.0.3 and
15.5 ESD #1

No Yes No Yes

Planning Your Installation
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Database Repository Source Destination Stage

Sybase SQL Anywhere
Server 11.0.1

Note: Sybase recom-
mends that you use
SQL Anywhere 11.0 as
an IQ InfoPrimer repo-
sitory.

Yes Yes No Yes

Sybase IQ 15.3 No Yes Yes Yes

IBM DB2 UDB 9.1 and
9.7

No Yes No No

Microsoft SQL Server
2005 SP2 and 2008 R2

No Yes No No

MySQL 5.1 No Yes No No

Oracle 10g and 11g No Yes No No

Note: See the documentation for your database for information about supported platforms.

Compatible Products
Learn about the Sybase products compatible with Sybase IQ InfoPrimer.

Product Version

Replication Server® 15.5 or later

Open Client/Server™ 15.5 or later

Replication Agent™ 15.5 or later

Replication Agent for Oracle 15.5

Sybase IQ 15.3

Sybase Software Asset Management (SySAM) 2.2.0.5

Note: The Change Data Capture (CDC) Provider Sybase Replication Server component is not
supported for Replication Server 15.6 or Replication Agent for Oracle 15.6 when the data
source is Oracle.

For product certifications, go to http://certification.sybase.com/ucr/search.do.

Planning Your Installation
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Installing Sybase IQ InfoPrimer

Install Sybase IQ InfoPrimer using the setup program included in your installation media.

Prerequisites

• Close any open applications or utilities.
• Make sure that the target computer meets the hardware and operating system

requirements.
• Make sure that you have the necessary licenses available in your installation environment.
• Make sure that you have the administrator rights to install grid node service.
• (UNIX and Linux) Make sure that you have uudecode utility installed in /usr/bin/

uudecode.

Task

You can download and extract the Sybase IQ InfoPrimer component images from the Sybase
Product Download Center (SPDC) at https://sybase.subscribenet.com

Warning! Do not install IQ InfoPrimer Development or IQ InfoPrimer Server in the same
directory as Sybase IQ 15.3.

Task
Perform this:

• Install IQ InfoPrimer Development using either GUI mode or silent mode.
However, Sybase recommends that you use GUI mode. By default, IQ InfoPrimer
Development is installed in C:\Sybase\IQIPD-15_3.

• Install IQ InfoPrimer Server using GUI mode and non-GUI modes. By default, IQ
InfoPrimer Server is installed in C:\Sybase\IQIPS-15_3

Note: GUI mode installation is only available on Windows platforms.

Next
Configure the drivers.

See also
• Drivers for Connecting to Sybase IQ on page 27

Installing Sybase IQ InfoPrimer
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Installing Sybase IQ InfoPrimer Development in GUI Mode
Use GUI mode to install Sybase IQ InfoPrimer Development. This allows you to install the
components using a graphical user interface.

1. Run the setup program if it does not start automatically.

To do it, select Start > Run and browse to
Setup_InfoPrimerDevelopment-15.3.0.exe.

2. Specify the language to use for installation. Click OK, then click Next.

3. Read and accept the license agreement. Click Next.

4. Close all other applications, specifically grid node, before proceeding. Click Next.

Note: To terminate grid node, run the grid node --shutdown command.

5. Click Browse to select an installation directory, click Next to accept the default directory,
or enter a new directory to be created. Sybase recommends that you use only alphanumeric
characters for the installation path.

Warning! Do not install IQ InfoPrimer Development in the same installation directory as
Sybase IQ.

6. Specify the Start Menu folder in which to create a program shortcut.

7. Select Install for All Users to launch the application on user accounts with restricted
access rights.

Note: For Windows 7 and Windows 2008, “Install for All Users” is the default selection. If
you are installing IQ InfoPrimer Development in the default location, unselecting this
option may cause errors.

When started the first time on a user account, all files requiring write privileges are copied
to the user directory, typically at:

• Windows 2003 and Windows XP – C:\Documents and Settings\<login
user>\Application Data\SYBASE\Sybase IQ InfoPrimer
Development\<product version>

• Windows 7 and Windows 2008 – C:\Users\<login user>\AppData
\Roaming\SYBASE\Sybase IQ InfoPrimer Development
\<product version>

Select Create a desktop icon, then click Next.

8. Review the installation summary information, and click Install.

9. When the installation finished, read the Readme file, then click Next.

10. Click Finish.

Installing Sybase IQ InfoPrimer
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Installing Sybase IQ InfoPrimer Server in GUI Mode
Use GUI mode to install IQ InfoPrimer Server. This allows you to intall the components using
a graphical user interface.

Note: You cannot install IQ InfoPrimer Server on UNIX and Linux using the GUI mode. To
install IQ InfoPrimer Server on these platforms, use the console or silent mode.

1. Run the setup program if it does not start automatically.

To do it, select Start > Run and browse to
Setup_InfoPrimerServer-15.3.0.exe.

2. Select the language to use for installation. Click OK, then click Next.

3. Select the product edition:

• Evaluation – allows you to install and use IQ InfoPrimer Server without a license for 30
days. To continue using IQ InfoPrimer Server after the end of the grace period, you
must obtain valid licenses from the SPDC.

• Licensed Edition – requires you to provide a license for installation.

4. Read and accept the license agreement. Click Next.

5. Close all other applications, specifically grid node, before proceeding. Click Next.

Note: To terminate grid node, run the grid node--shutdown command.

6. Select the installation directory. Sybase recommends that you use only alphanumeric
characters in the installation path.

Warning! Do not install IQ InfoPrimer Server in the same installation directory as Sybase
IQ.

7. Specify the Start Menu folder in which to create a program shortcut.

8. Select Register as Windows System Service to start or stop IQ InfoPrimer Server using
services.

Select Install for All Users to launch the application on user accounts with restricted
access rights.

Note: For Windows 7 and Windows 2008, “Install for All Users” is the default selection. If
you have selected to install IQ InfoPrimer Development in the default location,
unselecting this option may cause errors.

When started the first time on a user account, all files requiring write privileges are copied
to the user directory, typically at:

Installing Sybase IQ InfoPrimer
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• Windows 2003 and Windows XP – C:\Documents and Settings\<login
user>\Application Data\SYBASE\Sybase IQ InfoPrimer
Server\<product version>

• Windows 7 and Windows 2008 – C:\Users\<login user>\AppData
\Roaming\SYBASE\Sybase IQ InfoPrimer Server\<product
version>

Depending on whether you have selected “Install for All Users,” log files are located in the
\log subdirectory of either the user or the installation directory.

Click Next.

9. Review the installation summary information, then click Install.

10. When the installation is finished, read the Readme file, then click Next.

11. If you have installed the Licensed Edition, the installer prompts you to select the license
method:
• Use previously deployed license server – enter the license server host name of the

machine where the license server is running, and the license server port number if the
port number you are using is not the same as the default. Click Next.

Note: If you encounter issues providing the host name, provide the IP address of the
host machine instead.

• License file – select the location of the license file. Click Next.
The installer verifies whether the license is valid. If the license cannot be validated, you
can continue with the installation; however, the product will stop working in 30 days,
unless you obtain and install an appropriate license.

12. Click Finish.

Note: You cannot install IQ InfoPrimer Server on UNIX and Linux using the GUI mode. To
install IQ InfoPrimer Server on these platforms, use the non-GUI modes.

Installing Sybase IQ InfoPrimer on Windows Using Silent
Mode

Silent installation allows you to install components, but does not require interaction.
At the command prompt, navigate to the installation directory and enter:

• Sybase IQ InfoPrimer Development
Setup_InfoPrimerDevelopment-15.3.0.exe /VERYSILENT /
DIR=installation
directory /TASKS="Desktopicon,Allusers"

• Sybase IQ InfoPrimer Server
Setup_InfoPrimerServer-15.3.0.exe /VERYSILENT /DIR=<installation
directory> /TASKS="InstallAsService,Allusers"

where:

Installing Sybase IQ InfoPrimer
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• DIR – is the location to install IQ InfoPrimer Development or Server. Sybase recommends
that you use only alphanumeric characters and do not include white spaces in the
installation path.

• (Optional) TASKS – are the additional tasks you want the installer to perform, such as
creating a desktop icon for IQ InfoPrimer Development, installing IQ InfoPrimer Server as
a Windows service, or installing for all users.

Installing Sybase IQ InfoPrimer Server On UNIX and Linux
Using Console Mode

Use console mode to install IQ InfoPrimer Server on UNIX and Linux.

1. At the command prompt, change to the installation directory, and launch the setup
program:

InfoPrimerServer-15.3.0.shar

2. Specify whether to install an evaluation copy or a licensed copy:

• Enter 1 to install and use IQ InfoPrimer Server without a license for 30 days. To
continue using IQ InfoPrimer Server after the grace period, you must obtain valid
licenses from the SPDC.

• Enter 2 to install and use IQ InfoPrimer Server with a license.

3. A list of countries or regions appear. Select your location and press Enter. If you agree to
the terms of the license agreement, enter “Y” to continue the installation.

4. Enter the directory in which to install IQ InfoPrimer Server.

Note: Do not use folder names with spaces on UNIX or Linux.

Press ENTER to accept the default.

If the directory exists, this message appears:
The specified directory already exists and will be overwritten. 
[y/n]

otherwise, this message appears:
Installation directory does not exist. Create? [y/n]

5. Enter “Y” to install for all users, to launch the application on user accounts with restricted
access rights.

When all files are started the first time on a user account, those requiring write privileges
are copied to the user directory, typically, $HOME/SYBASE/Sybase IQ
InfoPrimer Server/<product_version>/Demodata.

Depending on whether you have selected to install for users, the log files will be located in
the \log subdirectory of either the user or the installation directory.

6. If you have installed a licensed copy, select one of these license methods:

Installing Sybase IQ InfoPrimer
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• Use license file – enter 1 to provide the location of the license file.

Note: After you provide the license, the installer verifies whether the license is valid. If
the license cannot be verified, you can continue with the installation; however, the
product will stop working in 30 days, unless you obtain and install an appropriate
license.

• Use previously deployed license server – enter 2 if you have a previously deployed
license server.
Enter the license server host name of the machine where the license server is running,
and the license server port number if the port number you are using is not the same as
the default.

You see a message indicating a successful installation.

See also
• Checking the InfoPrimer Server Installation on page 23
• Checking the Sybase IQ InfoPrimer Development Installation on page 21
• Configuring Connectivity on page 26

Installing Sybase IQ InfoPrimer Server on UNIX and Linux
Using Silent Mode

Use silent mode to install IQ InfoPrimer Server on UNIX and Linux.

1. At the command prompt, navigate to the installation directory and enter:

InfoPrimerServer-15.3.0.shar --silent --destination <dest> 
--all-user

where:
• destination <dest> – is where you want to install IQ InfoPrimer Server. Sybase

recommends that you use only alphanumeric characters and do not include white
spaces in the installation path.

• all-user – allows you to launch the application on user accounts with restricted access
rights.

2. After successful installation, copy the license into the licenses folder of the installation
directory.

To deploy the license to an existing license server, create a .lic file and copy it to the
licenses folder after you have added this information:
• License server host name of the machine where the license server is running.
• License server port number if the port number you are using is not the same as the

default.

For example:

Installing Sybase IQ InfoPrimer
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"SERVER sysamserver ANY 27000
 USE_SERVER"

where sysamserver is the host name of the machine where the license server is running, and
27000 is the default port number of the license server. See the Sybase Software Asset
Management Users Guide.

See also
• Checking the InfoPrimer Server Installation on page 23

• Checking the Sybase IQ InfoPrimer Development Installation on page 21

• Configuring Connectivity on page 26

Installing Sybase IQ InfoPrimer
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Installing SQL Anywhere as an IQ InfoPrimer
Repository

SQL Anywhere 11 is installed and configured when you install IQ InfoPrimer Development.
It is recommended version for use as an IQ InfoPrimer repository. SQL Anywhere 11 is also
packaged with IQ InfoPrimer Server and can be manually installed.

Note: SQL Anywhere 11 is not supported on Linux PPC64 platforms.

If you are using a repository other than SQL Anywhere from an earlier version of ETL, you
must migrate your existing ETL repository to SQL Anywhere 11.

Note: Each SQL Anywhere database can support only one IQ InfoPrimer repository. You may
encounter errors if multiple schemas in a SQL Anywhere database contain multiple sets of
repository tables.

After installing SQL Anywhere, you must configure the SQL Anywhere ODBC drivers.

See the SQL Anywhere documentation installed by the SQL Anywhere installer, for
information on how to set up a repository database.

See also
• Configuring SQL Anywhere ODBC Drivers for UNIX and Linux on page 27

Installing SQL Anywhere on Windows
Install SQL Anywhere as an IQ InfoPrimer repository on Windows.

1. Navigate to the installation directory to run the SQL Anywhere 11 installer.

2. Unzip and extract the SQLAnywhere11.zip file.

By default, the files are extracted to the installation directory.

3. Navigate to the SQLAnywhere folder and double-click setup.exe.

4. Select the language for installation and click OK.

5. Select Install SQL Anywhere 11.

6. On the Welcome window, click Next.

7. Select, read, and accept the license agreement. Click Next.

8. Enter the license key, which is in the SA11_license_key.txt file in the installation
directory.

Click Next.

9. Accept the default server license information and click Next.

Installing SQL Anywhere as an IQ InfoPrimer Repository
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10. Select the setup type and click Next.

11. Click Install.

12. View the README file or the iAnywhere Online Resources.

13. Click Finish.

Installing SQL Anywhere on UNIX and Linux
Install SQL Anywhere as an IQ InfoPrimer repository on UNIX and Linux.

1. Navigate to the installation directory.

2. Unzip and extract the SQLAnywhere11.tar.gz file.

For example:

gunzip SQLAnywhere11.tar.gz
tar -xvf SQLAnywhere11.tar

3. Navigate to the folder where you have extracted the file, and enter:
./setup

Note: When installing SQL Anywhere on Solaris, include /bin before /usr/ucb/bin
in the PATH variable.

4. Select the language for installation.

5. Read the license agreement, and enter Y to accept the agreement.

6. Enter the license key, which is in the SA11_license_key.txt file in the installation
directory.

7. Select the components you want to install.

8. Enter the installation directory.

9. Check the current setting and options, then enter Y to accept the settings.

10. Enter the license information.

11. Press ENTER.

12. Check for updates, then select to view the README file.

Creating Repository Tables
Create the repository tables once the SQL Anywhere database is running on the server, then
connect to the repository.

Prerequisites

1. Configure an ODBC datasource to connect to the SQL Anywhere database on your UNIX
machine.
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2. Test the ODBC datasource connection.

Task

1. Click Start > Programs > Sybase > Sybase IQ InfoPrimer Development 15.3 > Sybase
IQ InfoPrimer Development to launch Sybase IQ InfoPrimer Development.

2. In the Repository window, click Add.

3. Set up the repository connection.

a) Enter a repository name.
b) Select ODBC from the Interface list.
c) Select or enter the ODBC datasource name.
d) Enter dba as the user and sql as the password.

e) Leave Database and Schema blank.

4. Click Test Logon.

5. Click Yes to create the repository tables.

6. Click OK, then click Save.

7. Back in the Repository window, click Register new user checkbox.

8. (Optional) Change the Client, Client user, and Password values.

The default client password is "transformer".

9. Click Logon to create the new repository user.

10. In the Confirm Password window, enter the client password in the Repeat Password field,
then click OK.
You are now connected to your new repository and you can start creating IQ InfoPrimer
projects.
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Postinstallation Tasks

Learn about the Sybase IQ InfoPrimer post installation tasks.

Checking the Sybase IQ InfoPrimer Development
Installation

Verify that IQ InfoPrimer Development has been successfully installed.

1. In Windows, select Start > Programs > Sybase > Sybase IQ InfoPrimer Development
15.3 > Sybase IQ InfoPrimer Development.

2. The repository login window shows these values:

• Connection – Repository

• Client – transformer

• Client user name – TRANSFORMER

• Password – transformer

These values provide access to the ETL demo repository and are automatically set the
first time you log in. On subsequent logins, you might need to select or enter this
information.

3. Click Logon. If you can successfully log in to IQ InfoPrimer demo repository, the
installation is successful.

To configure your own working repository, see the Sybase IQ InfoPrimer Users Guide >
Administration Tasks.

Restoring ODBC Datasources
Restore the initial set of datasources that are created by the Sybase IQ InfoPrimer installer if
you are logging in to the demonstration repository. If repository datasources are lost for any
reason, Sybase IQ InfoPrimer cannot access or execute the demonstration projects until you
restore them.

Note: This procedure restores only the datasources; it does not restore the demonstration
repository and databases to their initial state.

1. Configure the ODBC user datasource, when the Sybase IQ InfoPrimer is installed for a
single user:

a) Select Start > Settings > Control Panel > Administrative Tools > Data Sources
(ODBC).
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On Windows 7 and 2008, select Start > Control Panel > System and Security >
Administrative Tools > Data Sources(ODBC).

Note: To administer datasources on a 64-bit machine, run odbcad32.exe from C:
\WINDOWS\SysWOW64.

b) Click Add.
c) Select SQL Anywhere 11. Click Finish.
d) Enter DEMO_Repository as the ODBC datasource name.

e) Click the Login tab and enter dba as the user ID and sql as the password.

f) Click the Database tab and in the Start line field, enter the installation location. The
default is C:\Sybase\IQIPD-15_3\dbeng11.exe.

Note: IQ InfoPrimer Development runs dbeng11.exe for configuring the IQ
InfoPrimer repository. dbeng11.exe is a single-user database that cannot be
accessed from other machines. To access the repository from another machine, specify
dbsrv11.exe instead of dbeng11.exe in the Start line field.

g) Edit the Database file field:

• If the application is installed for a single user in the default location, enter C:
\Sybase\IQIPD-15_3\demodata\demo_rep.db

• If the application is installed for all users:
• For Windows XP or 2003 – enter C:\Documents and Settings

\<login user>\Application Data\SYBASE\Sybase IQ
InfoPrimer Development\<product version>\Demodata
\demo_rep.db.

• For Windows 7 and 2008 – enter C:\Users\<login user>\AppData
\Roaming\SYBASE\Sybase IQ InfoPrimer Development
\<product version>\Demodata\demo_rep.db.

h) Click the ODBC tab and click Test Connection.

2. Set up the repository connection:

a) Select File > Open Repository.
b) Select Repository from the Connection list and choose:

• Edit or,
• Add, and enter a name for the connection.

c) Select ODBC from the Interface list.
d) Select DEMO_Repository from the Host list.
e) Click Save.

3. Configure the additional ODBC user datasources required by the projects in the demo
repository:

• Driver – SQL Anywhere 11
• Name – ETLDEMO_DWH; database – demo_dwh.db
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• Name – ETLDEMO_GER; database – demo_ger.db
• Name – ETLDEMO_US; database – demo_us.db

The database files for these user datasources are also located in the Demodata folder of
the installation directory, when installed for a single user, or in the user data directory,
when installed for all users.

Checking the InfoPrimer Server Installation
Verify that the IQ InfoPrimer Server is successfully installed.
Navigate to where IQ InfoPrimer Server is installed, and enter:

• Windows –
GridNode.exe -ll

• UNIX and Linux –
GridNode.sh -ll

If you see license information, the installation is valid.

Configuring Database Client Driver Environment Variables
on UNIX

Set up the database client driver environment variables before executing configure.sh.

Prerequisites

1. See Sybase IQ InfoPrimer Installation Guide > Planning Your Installation > System
Requirements > Sybase IQ InfoPrimer Server > Interfaces > Interfaces Driver Versions

2. See the installation document published by each database client vendor for instructions in
installing the database client.

Task

1. Set ODBCINI to the ODBC configuration file .odbc.ini.

# Set the Common ODBC environment.
setenv ODBCINI /path/to/.odbc.ini

2. Set ORACLE_HOME and TNS_ADMIN to the installed database instance client driver
path.

# Set the Oracle Instant Client environment
    setenv ORACLE_HOME /path/to/oracle/home
    setenv TNS_ADMIN /path/to/oracle/home

3. If you are using DB2, execute db2cshrc script before using its drivers.
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# Set the DB2 client environment
source /path/to/db2_client/home/nedb2i7/sqllib/db2cshrc

4. Set LD_LIBRARY_PATH to the database driver library files path.

# Set the LD_LIBRARY_PATH variable is reset to add the Oracle OCI
setenv LD_LIBRARY_PATH.
setenv LD_LIBRARY_PATH /path/to/oracle/home/libfolder/:
$LD_LIBRARY_PATH
setenv LD_LIBRARY_PATH 
/path/to/IQ153C:/path/to/IQ153C/IQ-15_3:/path/to/IQ153C/IQ-15_3/
lib64:$LD_LIBRARY_PATH

Note:
• On AIX platforms, use the environment variable LIBPATH instead of

LD_LIBRARY_PATH.
• The environment variables setting for HP and Linux platforms is the same as the

Solaris platform.
• On Windows platform, you do not need to set up the environment variables for the

database client except for ORACLE_HOME.

5. Modify the configure.sh file.

Note: Remove the comment for the Open Client environment settings to use the embedded
Open Client in IQ InfoPrimer.

6. Place the Open Client interfaces file in $SYBASE.

7. Execute configure.sh.

This generates the GridNode.sh needed to execute the IQ InfoPrimer gridnode server.

Starting Sybase IQ InfoPrimer Server
Start the Sybase IQ InfoPrimer Server using the command prompt.

Change to the Sybase IQ InfoPrimer Server installation directory:

On Windows, enter:

GridNode

GridNode --port 5500

On Linux and UNIX, enter:
GridNode.sh

GridNode.sh --port 5500

The GridNode.sh script is generated by  script $SYBASE/SybaseIQIPServer/
configure.sh, which may be run during or after the IQIP Server installation.

On Linux and Unix, to update the Sybase IQ InfoPrimer Server configuration with:
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• Sybase environment information, change to the Sybase IQ InfoPrimer Server installation
directory and run the configure.sh file in the same session where the $SYBASE
variables are set.

• Oracle environment information, change to the Sybase IQ InfoPrimer Server installation
directory and run the configure.sh file in the same session where the
$ORACLE_HOME and $TNS_ADMIN variables are set.

• IBM DB2 environment information, change to the Sybase IQ InfoPrimer Server
installation directory and run the configure.sh file in the same session where the
$DB2INSTANCE and $DB2DIR variables are set.

Starting Sybase IQ InfoPrimer Server as a Windows System
Service

You can install and run Sybase IQ InfoPrimer Server as a Windows system service. To run it as
a system service independently of the Windows GUI, start the IQ InfoPrimer Server after
system start-up using a system user account.

Note: You must have administrator privileges to install, remove, start, and stop a system
service.

To install the server as a Windows system service, enter:

GridNode.exe --install [additional parameters]

To remove the service, enter:

GridNode.exe --remove

When you run Sybase IQ InfoPrimer Server as a Windows service, basic events (failures,
success messages, and so on) are written to the Windows event log.

Note: On Windows 7, you need to be an administrator to install the GridNode as a system
service.

Stopping Sybase IQ InfoPrimer Server
You can stop a server from the console if it is a local or remote process. All currently running
projects complete execution before the server stops.
On Windows, enter:

GridNode --shutdown

GridNode --shutdown --server [remotehost] --port [port]

On Linux and UNIX, enter:

GridNode.sh --shutdown
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GridNode.sh --shutdown --server[remotehost] --port [port]

Note: To stop a grid engine running on a specified server and port, you must provide the server
name and port number. If you do not provide the server name and port number, the local grid
engine at the default port is stopped.

Configuring InfoPrimer Server on UNIX
Configure initialization file settings for IQ InfoPrimer Server. On UNIX, initialization
(.ini) file settings are not read by IQ InfoPrimer Server, unless you have a GridNode.ini
file.

1. In the etc folder of your installation directory, make a copy of the Default.ini file
named GridNode.ini.

2. In the Default.ini, specify general settings to be shared by all applications.

3. In GridNode.ini, specify exclusive settings for IQ InfoPrimer Server, and remove
general settings.

Configuring Connectivity
Set up connectivity between Sybase IQ InfoPrimer components.

1. Open IQ InfoPrimer Development and select File > Preferences.

2. Select Engine.

3. In the Execution engine server field, specify the IP address or machine name of the grid
engine server.

4. In the Execution engine port field, specify the communication port of the grid engine
server.

5. Click Save.
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Drivers for Connecting to Sybase IQ
Lists the drivers you can use to connect to Sybase IQ.

Sybase IQ ver-
sion

Drivers Details

15.3 Sybase IQ ODBC drivers The ODBC drivers packaged with Sybase IQ
15.3 should be used.

Note: Windows requires 32-bit ODBC drivers
for both 32-bit and 64-bit platforms. Linux-x86
requires 32-bit ODBC drivers for 32-bit plat-
forms and 64-bit ODBC drivers for 64-bit plat-
forms.

Open Client drivers These drivers ship with Sybase IQ InfoPrimer
are only copied to the disk and must be config-
ured manually. You can find these drivers in
<iqip_install_dir>\ocs.

Configuring SQL Anywhere ODBC Drivers for UNIX and Linux
Set up SQL Anywhere ODBC drivers for Sybase IQ 15.3.

The conventions used are:

• <installation_directory> is where SQL Anywhere is installed.
• <lib_version> is the subdirectory containing the SQL Anywhere 11 drivers. Depending on

your configuration, the name of the subdirectory is lib32 or lib64.

• $USERHOME is the home directory that contains the .odbc.ini file.

1. In the <installation_directory>, create a symbolic link called libodbc.so to the
supplied SQL Anywhere 11 ODBC driver file:

ln -s <installation_directory>/<lib_version>/libdbodbc11.so libodbc.so

2. In the .odbc.ini file, add an entry similar to:

[My_IQ_Server]
Driver=/opt/sybase/<installation_directory>/<lib_version>
/libdbodbc11.so
uid=dba
pwd=SQL
EngineName=My_IQ_Server_iqdemo
CommLinks=tcpip(host=iq_hosting_server;port=2638)
AutoStop=no
DatabaseName=iqdemo

3. Add the environment variable ODBCINI=$USERHOME/.odbc.ini to your server.
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4. To set the necessary environment variables, run the sa_config.sh or
sa_config.csh file in the <installation_directory>/<bin_version>/ directory, where
<bin_version> can be bin32 or bin64, depending on your configuration.

Note: If you have multiple Sybase IQ servers with the same server name, database name, and
port number, use server name caching to connect to the target Sybase IQ server. Add the
DoBroadcast=DIRECT communication parameter to the CommLinks connection parameter,
in the .odbc.ini file, in your IQ InfoPrimer Server:

CommLinks=tcpip(DoBroadCast=DIRECT;
host=iq_hosting_server;port=2638)

See Sybase IQ 15.2 System Administration Guide: Volume 1 > Connection and
Communication Parameters > Network Communications parameters.

Configuring Open Client Drivers on Windows
Set up the Open Client drivers for Sybase IQ 15.3 on Windows.

1. Set these environment variables:

SYBASE = <install_dir>\ocs

SYBASE_OCS = OCS-15_0

PATH = %SYBASE%\%SYBASE_OCS%\bin;%SYBASE%\
%SYBASE_OCS%\dll

2. Use the dsedit utility to create an entry for your server in the sql.ini file.

For example:
[myiqserver]
master=TCP,myiqhost,2638
query=TCP,myiqhost,2638

Configuring Open Client Drivers on UNIX and Linux
Set up the Open Client drivers for Sybase IQ 15.3 on UNIX and Linux.

1. Navigate to the installation directory and use a text editor to open the GridNode.sh
file.

2. Set the environment variables by uncommenting these lines:

#SYBASE=<install_dir>/ocs
#export SYBASE
#SYBASE_OCS=OCS-15_0
#export SYBASE_OCS
#LD_LIBRARY_PATH=<install_dir>/ocs/OCS15_0/lib:${LD_LIBRARY_PATH}
#export LD_LIBRARY_PATH
#LIBPATH=<install_dir>/ocs/OCS-15_0/lib:${LIBPATH}
#export LIBPATH

3. Create an entry for your server in the <install_dir>/ocs/interfaces file.

For example:   
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myiqserver

master tcp ether myiqhost 2638
query tcp ether myiqhost 2638
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Uninstallation

Uninstall the product.

Prerequisites
Learn about the tasks to perform before uninstallation.

• Log in to your machine using an account with administrator privileges.
• Shut down all Sybase applications and processes.
• Move any log, database, or user-created files that you want to keep from the installation

directory to another location.
• Determine the mode of uninstallation—GUI or silent mode. Sybase recommends that you

use the GUI mode on Windows, and console mode on UNIX and Linux to uninstall.
• If IQ InfoPrimer Development was installed for all users, before uninstalling it, Sybase

recommends that you log in as each user, and use the ODBC Data Source Administrator to
remove the DEMO_Repository, ETLDEMO_DWH, ETLDEMO_GER, and
ETLDEMO_US datasources.

Uninstalling IQ InfoPrimer Development in GUI Mode
Uninstall IQ InfoPrimer development using GUI mode .

1. Select Start > Settings > Control Panel > (Add or Remove Programs / Programs and
Features). Select Sybase IQ InfoPrimer Development 15.3 and click Remove.

Confirm removal and click Next.

2. When the uninstallation is complete, click OK.

Some files and directories remain after uninstallation. If IQ InfoPrimer Development was
installed for all users, delete the user data directories from:

• On Windows 2003 and Windows XP – C:\Documents and Settings\<login
user>\Application Data\SYBASE\Sybase IQ InfoPrimer
Development\<product version>

• On Windows 7 and Windows 2008 – C:\Users\<login user>\AppData
\Roaming\SYBASE\Sybase IQ InfoPrimer Development\<product
version>
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Uninstalling Sybase IQ InfoPrimer Development or Server in
Silent Mode

Use silent mode to uninstall Sybase IQ InfoPrimer Development or Server.
At the command prompt, navigate to the installation directory and enter:

unins000.exe /verysilent

Uninstalling Sybase IQ InfoPrimer Server in GUI Mode
(Windows)

Use GUI mode to uninstall IQ InfoPrimer Server on Windows; you cannot use console or
silent mode.

1. Select Start > Settings > Control Panel > (Add or Remove Programs / Programs and
Features). Select Sybase IQ InfoPrimer 15.3 and click Remove to launch the uninstaller,
then click Yes to confirm.

2. A status bar displays the progress of the uninstallation. When the uninstallation is
complete, click OK to exit the uninstaller.

Uninstalling Sybase IQ InfoPrimer Server in Console Mode
(UNIX and Linux)

Use console mode to uninstall IQ InfoPrimer Server in UNIX and Linux; you cannot use GUI
mode.

1. Navigate to the installation directory and enter:

./uninstall 

2. Enter Yes to confirm that you want to completely remove IQ InfoPrimer Server and all of
its components.

Note: Some files and directories may not be removed during uninstallation. Manually
delete these files and directories.

Uninstalling Sybase IQ InfoPrimer Server in Silent Mode
(UNIX and Linux)

Use silent mode to uninstall Sybase IQ InfoPrimer Server in UNIX and Linux.
At the command prompt, navigate to the installation directory and enter:
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./uninstall --silent
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Upgrading Sybase ETL 4.9 to Sybase IQ
InfoPrimer

Upgrade Sybase ETL Development and Sybase ETL Server to Sybase IQ InfoPrimer .

Upgrading Sybase ETL Development
Upgrade ETL Development to IQ InfoPrimer Development.

Prerequisites
Shutdown all Sybase ETL Development and/or ETL Server processes running on the same
machine. To verify, go to the Windows Task Manager and click the Processes tab to check for
the ETLDev.exe and GridNode.exe processes. If running, select the appropriate process
and click End Process.

Note: Make sure Show Processes From All Users is selected.

Task

1. Install IQ InfoPrimer Development. You can:

• Leave ETL Development and install IQ InfoPrimer Development in a different
directory, or

• Uninstall the ETL Development and install IQ InfoPrimer Development. Before
uninstalling, back up the .ini files in the etc directory. Uninstalling removes the
demo datasource entries for the user who performs the uninstallation.

2. If ETL Development was installed for all users and you want to use the new IQ InfoPrimer
demo datasources, rename or delete the demo datasources for each user before upgrading.
Log in as each user and use the ODBC Data Source Administrator to rename or delete
DEMO_Repository, ETLDEMO_DWH, ETLDEMO_GER, and ETLDEMO_US
datasources.

If you did not remove the ETL Development user directories for each user, and you want to
continue using the existing ETL demo datasources, you can skip this step.

3. If your .ini files contain modifications that you want to keep, copy the .ini files from
the etc folder of the earlier installation directory to the new installation directory.

4. Start IQ InfoPrimer Development. In the IQ InfoPrimer Development Repository Login
window, select the repository to connect to and provide the user name and password that
was used to connect to the repository in the ETL Development.
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Note: You must recreate any repository connections that you created for ETL 4.9
Development in order to use them in IQ InfoPrimer.

Upgrading Sybase ETL Server on Windows
Upgrade Sybase ETL Server to Sybase IQ InfoPrimer on Windows.

Prerequisites
Go to the Windows Task Manager and click the Processes tab to check for any active
GridNode.exe process. If a GridNode.exe process is running, select it and click End
Process.

Note: Make sure Show Processes From All Users is selected.

Task

1. Install the IQ InfoPrimer Server. You can:

• Leave the earlier version of ETL Server and install the IQ InfoPrimer Server in a
different directory.

• Uninstall the earlier version and install IQ InfoPrimer Server.

Note: If you are uninstalling ETL, create a backup of the ODBC or native connectivity
files, including the .odbc.ini file or the ODBC or native drivers.

2. Start the IQ InfoPrimer Server.

• To start the IQ InfoPrimer Server directly, enter:
GridNode

• To start the IQ InfoPrimer Server as a service, enter:
GridNode --install

The default location of the GridNode.exe is C:\Sybase\IQIPS-15_3.

3. To verify whether the server has started, go to the Windows Task Manager and click the
Processes tab to check if the GridNode.exe process is running.

See also
• Installing Sybase IQ InfoPrimer Server in GUI Mode on page 11

• Uninstalling Sybase IQ InfoPrimer Server in GUI Mode (Windows) on page 32
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Upgrading Sybase ETL Server on UNIX and Linux
Upgrade ETL Server to Sybase IQ InfoPrimer Server on UNIX and Linux.

Prerequisites

• Shut down any running grid node. At the command prompt, enter:
./GridNode.sh --shutdown

• Verify that the grid node has shut down successfully:
ps -e | grep GridNode

If the grid node is still running, kill the process.

Task

1. Install the IQ InfoPrimer Server in a new installation directory.

2. Copy the .ini files from the etc folder of the earlier installation directory to the new
installation directory.

3. Start the IQ InfoPrimer Server.

• To start the IQ InfoPrimer Server directly, enter:
GridNode.sh

The default location of the GridNode.sh is /opt/SYBASE/
InfoPrimerServer.

4. Verify whether the server has started:

ps -e | grep GridNode

After successfully upgrading, you may uninstall the ETL Server.

See also
• Uninstalling Sybase IQ InfoPrimer Server in Console Mode (UNIX and Linux) on page
32

• Uninstalling Sybase IQ InfoPrimer Server in Silent Mode (UNIX and Linux) on page
32

Configuring a Repository Database
Access and define the ODBC datasource for the empty SQL Anywhere 11 repository.

Repositories are held in a collection of tables in a SQL Anywhere database. Sybase IQ
InfoPrimer allows physical separation of repositories by using multiple repository databases.
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1. Navigate to <IQIPD_install_directory>\etc, copy
repositoryEmpty.db and rename to a name of your choice. For example,
myRepository_IQIP153.db.

2. Configure the ODBC datasource names to define your own repository by creating a
System datasource that points to myRepository_IQIP153.db.

1. Select Start > Settings > Control Panel > Administrative Tools > Data Sources
(ODBC).

Note: To administer datasources on a 64-bit machine, run odbcad32.exe from C:
\WINDOWS\SysWOW64.

2. Click Add.
3. Select SQL Anywhere and click Finish.
4. Click the ODBC tab. In the Data source name field, enter

myRepository_IQIP153.

5. Click the Login tab and enter dba as the user ID and sql as the password.

6. Click the Database tab and enter these values:
• A server name.
• Start line – C:\Sybase\IQIPD-15_3\dbeng11.exe. This is the default

installation location.

Note: IQ InfoPrimer Development runs dbeng11.exe for configuring the IQ
InfoPrimer repository. dbeng11.exe is a single-user database that cannot be
accessed from other machines. To access the repository from another machine,
specify dbsrv11.exe instead of dbeng11.exe in the Start line field.

• Database file – C:\Sybase\IQIPD-15_3\etc\myRepository_
IQIP153.db.

7. Click the ODBC tab and click Test Connection to verify the connection.
8. Click OK.

Connecting to the Repository in IQ InfoPrimer Development
Connect to the IQ InfoPrimer Development repository.

1. Select Start > Programs > Sybase > Sybase IQ InfoPrimer Development 15.3 >
Sybase IQ InfoPrimer Development.

2. Set up the repository connection.

a) Click Add and enter myRepository_IQIP153 as the name.

b) Select ODBC from the Interface list.
c) Select myRepository_IQIP153 from the Host list.
d) Enter dba as the user and sql as the password.
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e) Click Test Logon.
f) Click Save.
g) Select Register new user and click Logon.
h) Enter transformer to confirm your password and click OK.
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Obtaining Help and Additional Information

Use the Sybase Getting Started CD, Product Documentation site, and online help to learn
more about this product release.

• The Getting Started CD (or download) – contains release bulletins and installation guides
in PDF format, and may contain other documents or updated information.

• Product Documentation at http://sybooks.sybase.com/ – is an online version of Sybase
documentation that you can access using a standard Web browser. You can browse
documents online, or download them as PDFs. In addition to product documentation, the
Web site also has links to EBFs/Maintenance, Technical Documents, Case Management,
Solved Cases, Community Forums/Newsgroups, and other resources.

• Online help in the product, if available.

To read or print PDF documents, you need Adobe Acrobat Reader, which is available as a free
download from the Adobe Web site.

Note: A more recent release bulletin, with critical product or document information added
after the product release, may be available from the Product Documentation Web site.

Technical Support
Get support for Sybase products.

If your organization has purchased a support contract for this product, then one or more of
your colleagues is designated as an authorized support contact. If you have any questions, or if
you need assistance during the installation process, ask a designated person to contact Sybase
Technical Support or the Sybase subsidiary in your area.

Downloading Sybase EBFs and Maintenance Reports
Get EBFs and maintenance reports from the Sybase Web site.

1. Point your Web browser to http://www.sybase.com/support.

2. From the menu bar or the slide-out menu, under Support, choose EBFs/Maintenance.

3. If prompted, enter your MySybase user name and password.

4. (Optional) Select a filter from the Display drop-down list, select a time frame, and click
Go.

5. Select a product.

Padlock icons indicate that you do not have download authorization for certain EBF/
Maintenance releases because you are not registered as an authorized support contact. If
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you have not registered, but have valid information provided by your Sybase
representative or through your support contract, click My Account to add the “Technical
Support Contact” role to your MySybase profile.

6. Click the Info icon to display the EBF/Maintenance report, or click the product description
to download the software.

Sybase Product and Component Certifications
Certification reports verify Sybase product performance on a particular platform.

To find the latest information about certifications:

• For partner product certifications, go to http://www.sybase.com/detail_list?id=9784
• For platform certifications, go to http://certification.sybase.com/ucr/search.do

Creating a MySybase Profile
MySybase is a free service that allows you to create a personalized view of Sybase Web pages.

1. Go to http://www.sybase.com/mysybase.

2. Click Register Now.

Accessibility Features
Accessibility ensures access to electronic information for all users, including those with
disabilities.

Documentation for Sybase products is available in an HTML version that is designed for
accessibility.

Vision impaired users can navigate through the online document with an adaptive technology
such as a screen reader, or view it with a screen enlarger.

Sybase HTML documentation has been tested for compliance with accessibility requirements
of Section 508 of the U.S Rehabilitation Act. Documents that comply with Section 508
generally also meet non-U.S. accessibility guidelines, such as the World Wide Web
Consortium (W3C) guidelines for Web sites.

Note: You may need to configure your accessibility tool for optimal use. Some screen readers
pronounce text based on its case; for example, they pronounce ALL UPPERCASE TEXT as
initials, and MixedCase Text as words. You might find it helpful to configure your tool to
announce syntax conventions. Consult the documentation for your tool.
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For information about how Sybase supports accessibility, see the Sybase Accessibility site: 
http://www.sybase.com/products/accessibility. The site includes links to information about
Section 508 and W3C standards.

You may find additional information about accessibility features in the product
documentation.
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